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Reference material: Wolfson and Pasachoff, Chapters 26 and 28.

Introduction


Most of the interesting applications of electronics involve phenomena that vary in time.  For example, your voice is transmitted over telephone wires by time-varying voltages, which cause a membrane in the speaker at the other end of the line to vibrate, thus recreating your voice.  In audio equipment, the information about sound is encoded as numbers on a compact disk, but can only be played back after these numbers have been transformed into time-varying voltages once again.  We sometimes use the word “signal” to mean a voltage that varies in time, whatever its origin.  Today we'll investigate two types of circuits involving time-dependent signals:  1) By using both a resistor of resistance R and a capacitor with capacitance C in the same circuit with a voltage supply that is switched between two levels, we'll explore how the voltages across the resistor and the capacitor vary in time.  You will use this information to measure C.   2) You will construct a filter, which will eliminate certain frequencies and allow others to pass.  As we’ll see, this filtering property of RC circuits is essential for the proper functioning of much electronic equipment.

Measuring Capacitance


Capacitors are discussed in Wolfson and Pasachoff.  You may want to refer to Section 28-6 on RC circuits when doing this lab if the discussion below is insufficient.  We will go over the following material at the start of the lab.


A capacitor is a device for storing charge that consists of a pair of separated conductors, such as two parallel plates.  The circuit symbol for a capacitor is [image: image1.wmf] .  If one plate of a capacitor has charge +Q and the other –Q, then the voltage V across the capacitor is related to the charge by






(1)

where the constant C, known as the capacitance, depends on the geometry of the conductors and the material that fills the gap between them.   Capacitance is measured in farads (F), where 1F = 1C/V.  A 1F capacitor would be very large.  Most of the capacitors we will use will be measured in terms of F (microfarads = 10-6 F) or pF (picofarads = 10-12 F).  A simple circuit involving a capacitor is shown in Figure 1.
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Figure 1:  RC Circuit

Initially the capacitor is uncharged.  Consider what will happen if the switch is placed in position A.  We can still apply Kirchoff’s laws so
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If we differentiate equation 2 with respect to time we obtain (remember that current is 
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Equation 3 is a linear differential equation for which the time derivative of the variable I(t) is proportional to I ;  therefore it has an exponential solution as you can easily check:
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Pre-lab question 1:  (a) Show by differentiating the expression for current in equation 4 that it satisfies equation 3.   (b) Why must the constant I0 have the value V0/R ? 

With this result in hand, we can express the voltage across the resistor and capacitor as
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 (exponential decay)
(5)





 (exponential growth)
(6)

Let us see how these voltages depend on time.  Initially (t  = 0), the current flows as if the capacitor were not present.  The current gradually increases the charge on the capacitor, thereby also increasing the voltage across it.  This in turn decreases the voltage across the resistor and the flow of current.  After a long time (t  >> RC) the capacitor is fully charged (VC = Vo) and no more current flows (I = 0; VR = 0).

Pre-lab question 2:  Sketch VR(t) and VC(t) , assuming that Vo = 1 V and RC = 0.1 s.   Label the points at which t = RC clearly on the axes with the appropriate values.


The time equal to RC is the characteristic time or relaxation time of the circuit; it is also called the time constant .  In fact is in seconds if R is measured in ohms and C is measured in farads.  Since the steady state is never reached, but only approached asymptotically, the time constant provides a way of estimating how long is required to charge the capacitor.  When t  = RC, then e‑t/RC = e-1 = 0.37.  After time t  = RC the capacitor has reached 63% of its full charge.  After t  = 5 RC the capacitor is charged to more than 99% of its full charge.  This charge storing function is an important use of capacitors; the storage of charge also amounts to the storage of energy.  


When analyzing circuits with capacitors, always remember that the voltage across a capacitor can never change discontinuously since voltage changes require charge to flow onto or off the plates.


Now assume that the capacitor in Figure 1 is fully charged, and that the switch is put in position B at time t  = 0.  You should remember from your studies of electricity and magnetism that the voltage across the capacitor is now given by





      (exponential decay)   .
(7) 

Filtering


Here we will observe an example of signal processing, the alteration of a time-varying voltage by a circuit to achieve some particular goal.  Our signal will be a dull one, merely sine waves provided by the function generator.  However, you would use essentially the same circuits to build a “rumble filter” for an audio amplifier (to eliminate frequencies below 20 Hz) or a “scratch filter” (to eliminate those greater than 20,000Hz.)  Combining both of these filters, to pass only the audible frequency range (20–20,000Hz), one would have constructed a so-called band pass filter. Similar circuits are used frequently in scientific measurements to filter out the sources of noise afflicting a particular experiment.  For a sensitive optical experiment, it might be the 60Hz background signal from the room lights, while for a vibration sensitive position measurement, it might be very low frequency vibrations from people walking around the laboratory.


In this part of the experiment, you will work with circuits in which the voltages and currents are periodic. An alternating voltage source (signal generator) can be used to drive a simple circuit composed only of resistors (see Figure 2).  The behavior of such an AC circuit can be deduced using the methods you already learned for DC circuits.
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Figure 2:  AC circuit with resistors

With an oscillating voltage source, the currents will not be constant, but will oscillate at the same frequency as the driving voltage.  The current in the circuit of Figure 2 will also be in phase with the voltage (i.e., when the source voltage reaches its maximum, so does the current).  Although the source voltage is always changing, Kirchoff’s Laws are satisfied at every instant in time.


AC circuits containing capacitors:  In addition to resistors, AC circuits can also include capacitors and inductors.  We will deal only with capacitors in this lab and leave inductors for the next lab.  Inductors and capacitors are discussed in Chapters 32 and 33 of Wolfson and Pasachoff.  When the circuit contains capacitors or inductors, the current is not always in phase with the applied voltage.

Experimental Procedure

Experiment 1:  Measuring a capacitance by exponential decay


In this experiment you will use the simple circuit of Figure 1 to determine the capacitance of a capacitor in two different ways.  You will use a PC with a LabPro Interface serving as a data logger to measure voltages as a function of time.  

1) Carefully construct the circuit shown in Figure 1 using a capacitor provided by the instructor; its value will be at least 3 F.  Select a resistance R of around 1 M so that the charging time will be rather long.  Measure R with the DMM, and record it.  Some capacitors are polarized, i.e., they must be connected in a certain orientation.  Look for marks indicating the + or – end of the capacitor and make your connections accordingly.
2) Now attach the voltage leads of the DMM to measure the voltage across your resistor.  This, of course, gives you the current as the capacitor is charged or discharged.  (Do not use the A [amps] setting on the DMM or you will blow a fuse.  Why?)
3) After you have checked that your circuit seems to be working, disconnect the DMM and connect the computer across the resistor instead.  Have your instructor check your circuit before you apply power to your circuit.
4) Double-click on the Logger Pro icon.  Once you are in Logger Pro, you will see a graph of voltage as a function of time.  
5) To gather voltage data, you simply click on the Collect button at the top of the screen.  It takes a moment for the program to begin, then it records voltages across the leads as a function of time for however long your plot’s x-axis indicates.  The range of the y- and x-axes can be adjusted using the View menu under Graph Options.  For example, if your voltages are too large to be displayed on your screen, you may increase the range of the y-axis to accommodate this. 
6) Place the switch in position to discharge the capacitor.  When the capacitor is fully discharged (i.e. VR = 0), make the following changes to the data logger setup.  Go to Experiment: Data Collection and choose the Triggering tab.  Set the trigger just below V0; e.g., with a 5 V supply voltage, set the trigger for greater than 4.8 V.  Next, choose the Sampling tab.  Set the sampling rate for 60 points per second.  (These changes will give you more accurate results.)  Now press Collect and wait for the “Waiting for trigger” message to appear on the screen.  Then move the switch to position A and record VR  as the capacitor is charging.  Adjust the length of time that you take data until you have captured all of the charging behavior of the capacitor.
7) Determine C by performing a fit to your data for VR during the capacitor charging process of an exponential decay curve as in equation 5.   To do this, go into the Analyze menu and choose the Curve Fit option.  Make sure your data display a clean decay curve before continuing.  Select the relevant curve and fit your data to that functional form.  A line will overlay your data, showing how well the fit corresponds to the actual measured curve.  If you have good agreement, print out your curve and record the value of the time constant.  Compute a value for the capacitance (call your measured value C1) and explain how you obtained it before continuing.  
8) Next, determine C in a different way, by measuring its stored charge.  Determine the total charge Q stored on the capacitor when it was fully charged by integrating I(t) during the charging process.  (Except for a constant factor, the current is of course the same as VR.)  The Logger Pro program has a built-in integration routine that you may use for this purpose.  To look at individual data points more closely, select the Analyze menu, then the Examine option.  You may then use a cursor to examine the data and do many different analysis tasks.  To integrate, select the Integral option, also under the Analyze menu.  (You will never capture the entire exponential, since it continues to evolve past your data set.)  The program automatically displays the area under the curve.  Make sure by examining the screen that the area used for this calculation makes sense.   From equation 1, determine a second value (call it C2) for C; show your calculations clearly.  Be careful of units.  (LATER, estimate the error introduced by not integrating all the way out to t = 
[image: image9.wmf]¥

.)   Hint:  The integral is easy and you can do it analytically.    If you missed any area at the start of the decay, try to estimate that as well.)

Make rough estimates of the uncertainty for the methods in steps 7 and 8 above.   Ask your instructor for the true value of C and compare your experimental values to it.

Experiment 2: Filters and Signal Processing


In this experiment you will observe the qualitative properties of a simple RC circuit that serves as a high pass filter.  

[image: image10.wmf]
Figure 3: A high pass filter.

The circuit shown in Figure 3 will pass high frequencies but not low frequencies.  The dividing point between these two regimes (where the output voltage signal is smaller than the input signal by a factor 
[image: image11.wmf]2

) is known as the "characteristic frequency" fc, which is predicted to be





.
(8)

(Often, this is called f3dB.  You’ve probably heard of decibels, abbreviated dB.  It turns out that 3dB is equivalent to a multiplicative factor of
[image: image12.wmf]2

.) Note that this frequency is (except for the factor of 2to convert from  to f) equal to the inverse of the characteristic charging time of the capacitor.  To understand the qualitative properties of this circuit, think of a capacitor as a device that behaves (a) like a short at high frequencies (where it never has time to charge up significantly), and (b) like an open circuit at low frequencies (where the capacitor has plenty of time to charge up, so VC is always close to Vin).  This circuit is often used when one wants to suppress low frequencies, e.g. when the low frequencies contain noise that is of no interest to the measurement.  It is also used to control the frequency response of an audio amplifier.

1)  Begin by spending about 10 minutes familiarizing yourself with the operation of the oscilloscope and the function generator.  Make sure that you can use the scope to measure voltages and time intervals.  

2) Assemble the circuit shown in Figure 3.  IMPORTANT:  Put the scope leads across the output of the circuit, with the ground lead of the scope (usually the black clip lead) at the same point in the circuit as the ground of the signal generator.  (The circuit will not work if these two grounds are connected to different points in the circuit. Explain why not.)   

3) Record and plot the output voltage over a wide range of frequencies (say 100 Hz to 50 kHz) to see the qualitative behavior described above.  It is sufficient to change the frequency by successive factors of 3.  Does your circuit indeed pass high frequencies?   

4) Measure the characteristic frequency fc.  Compare this to the theoretical characteristic frequency (use measured values for R and C).  Now increase R to several kilohms, and determine the characteristic frequency again; as always, compare with expectations.
Make a very rough guess as to the uncertainty in your measurements of the characteristic frequencies.    (You can assume the scales on the scope are accurate to about 3% of full scale if you read it carefully; the DMM is accurate to about 1%.)   

NOTE:  Your estimate of the uncertainty should not be obtained by finding the difference between the predicted and measured values!  Students often erroneously compute a "percentage error" in this fashion, but that quantity bears no relation to the uncertainty of the measurement!  The latter quantity does not depend on what the predicted value happens to be.  In many real experiments, there is no predicted value. 

Discuss any discrepancy if your resulting value for fc is larger than the range provided by your estimated uncertainty.   (Are there possible systematic errors that you have not taken into account?)

Experiment 3:  Low Pass Filter

The voltage across the capacitor has quite different frequency dependence than that across the resistor.  To study it, you might be tempted simply to move the scope leads.  However, the scope and generator grounds must be kept at the same potential.  Therefore, you will need to interchange the positions of the resistor and capacitor in Figure 3. 

Observe the output of the circuit qualitatively over the frequency range 100 Hz to 50 kHz. Find (and record) the frequency where the output is 
[image: image13.wmf]2
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of the maximum value.    

Give a simple explanation of why the high and low pass filters have the same characteristic frequency.   Also, give a qualitative explanation of the behavior of this circuit, i.e., of the fact that the output signal is strongly attenuated at high frequencies, using the rule of thumb that a capacitor acts like a short at high frequencies.

Optional Experiment 4:  Band pass filter


If you have extra time or wish to return another afternoon, you might try constructing a band pass filter, a combination high and low pass filter that attenuates both high and low frequencies.    Start by building a high pass filter and using the output of this as the input to the low pass filter.  For example, you could choose characteristic frequencies to be about 400 Hz and 6 kHz.  If possible, design the second stage of the filter to have a sufficiently high impedance that it won't "load" the first stage, bearing in mind the lessons learned in a previous lab.   Include a diagram of a working circuit (or even of a proposed circuit if you don't have time to try it).  


It’s possible to design even more elaborate devices, which first boost one range of frequencies during recording, so, e.g., the higher frequencies are recorded artificially loud.  As the recording ages, it acquires noise mixed in with the original recording; because many of the most common sources of noise consist of high frequency sounds (such as hiss on a tape deck or scratches on a phonograph album), most of the distortion in the recording occurs at that end of the frequency spectrum.  By passing the recording plus noise through a filter, which then suppresses the high frequency sounds, the correct intensity of the original sound is restored and the noise level is reduced.  This is the basic idea behind noise reduction systems such as Dolby, and it explains why music recorded with Dolby sounds distorted if not played back with the proper filters in place.
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